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i-Tree

Tools for Assessing and Managing Community Trees & Forests www.itreetools.org

What is i-Tree? 1 T

i-Tree is a suite of free software tools for estimating and quantifying the benefits 1- r ee
trees provide to our communities. These benefits are typically expressed in dollars and amounts of
carbon dioxide and air pollution removal (ozone, sulfur dioxide, etc.), as well as stormwater reduction.
Raising awareness of these tree benefits increases the desire to nurture and protect trees.

Who is using i-Tree?
« Teachers, students, & homeowners learning about trees beyond their aesthetic benefits.
« Companies investing in natural capital as part of their sustainability efforts.
« Governments & organizations improving their community forest management.
« Consultants & Innovators developing urban forest management plans, climate action plans, and
interactive tree maps for their clients and the public.

How does i-Tree work?

Structure Function Value
Assess the number of Statistically estimate functions (e.g. gas Apply monetary values to these
trees, species, condition + exchange) and covert to services such services based on economic
weather & pollution data. as CO, uptake & rainfall interception. models & published literature.

pe—

Where does i-Tree come from?
i-Tree was established in 2006 and is now
used around the world. Based on peer-
reviewed, publicly accessible USDA Forest
Service research, the mission of i-Tree is to
disseminate this science to large numbers of
diverse users in an easy to use format.

i-Tree is a non-profit, cooperative effort

among these partners:
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How do | get i-Tree?

Learn about these free tools at www.itreetools.org. Links to them as well as references,
project examples, and video learning segments are available. Want to ask a question?
User support is provided: info@itreetools.org.

Tree Benefits! Growing 20 years in Ohio, USA, one red maple can:
« Remove 3,000 pounds of carbon dioxide from the atmosphere.

% -« Filter 15 pounds of pollution from the air we breathe.

© o Save 500 kWh of electricity and 20 million BTU of fuel used for cooling & heating.

« Avoid 5,000 pounds of CO, and 30 pounds of pollution in powerplant emissions.

« Intercept 25,000 gallons of rainfall and avoid 4,500 gallons of runoff.
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Tools for Assessing and Managing Community Trees & Forests www.itreetools.org

MyTree "
Explore the benefits of I.Tree
trees near you. "
« Got 2 minutes?
« Go to mytree.itreetools.org on

your phone, tablet or laptop!

i-Tree Canopy i-Tree Landscape
Estimate tree & ground cover for a large project. Learn about your entire community.
« A free web tool: canopy.itreetools.org « A free web tool: landscape.itreetools.org
« Simple, random sampling of a project area to « US watersheds, cities, census areas & more
estimate tree and ground cover. « Get estimates of tree benefits in

« You also get total estimates of tree benefits: - 10 minutes:
CO; & air pollution removal - CO2 mitigation
- Stormwater reduction - air pollution removal

- stormwater reduction

4 easy steps & 30 minutes: .
- health benefits

1. Draw project boundaries on a Google map. : o "
2. Enter ground cover types to survey. « Generate planting prioritization scenarios.

3. Select the ground cover you see on the (S pepe———————

map at random, auto-selected locations. € = C | @ httpsy/landscape.itrestools.org
4. Click the Report button for results!

ﬂ i-Tree Landscape ,,,,.,  Home Project

Cover Class
Impervious Other
12 [Tree/shrub
[1mpervious Buildings
:Tree/Shrub

Grass/Herbaceous

¥

Tree/Shrub | B Caa 3
Impervious Road Canopy 02 equivaren:
Tree/Shrub -] Sequestration
Impervious Other o < acre s % S Siyr T tyr 3
Lakefront 6789 2364 94866 2495
Downtown 96442 2416 401,305 10,560.7
i-Tree Eco The Flats 28717 47.16 1,347,713 35466.1

For community forestry managers.
« A free tool for Windows PCs.
« Supports street tree inventory imports.
« Includes mobile phone/tablet field data collection tools for complete or sample inventories.
« The best i-Tree estimates for tree benefits with comprehensive reports.
« Download Eco at www.itreetools.org

I-Tree

Tools for Assessing and Managing Community Trees & Forests

OurTrees
Provides data on a community and it’s tree
cover.

* Quick tree canopy and related information
for any city or town within the continental
United States using your a browser or
Android / Apple device

« With inputs of a city or town it will estimate
the amount of carbon dioxide and air
pollution a city’s trees remove, as well as
stormwater impacts.

It's quick and easy! Just a couple of simple
steps to get results.

1. Enter your city or town’s name and state
2. Get a complete report immediately on your
smartphone or computer

OurTrees L3
™
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i-Tree Design

Estimate tree & ground
cover for a large project.

i-Tree

» Afree web tool:
design.itreetools.org

« Just input location, species, tree size, and
condition

+ Calculates greenhouse gas mitigation, air
quality improvements, and stormwater
interception.

4 simple steps in minutes:

1. 'Draw’ a building footprint on a Google Map

2. Virtually"plant" or place an existing or proposed
tree location

3. Select tree species and size

4. Repeat or click Report button for your results!

i-Tree Design vio
Get started with these easy sleps:
1. Draw Structures
2. Place Trees
Descrbe your tree:
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Urban Forests & Tree Canopy
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What is i-Tree?

® A suite of tools to assess urban vegetation and their ecosystem

services and values

i-Iree i-Iree.  i-Iree.  i-Iree  i-Iree

Eco Landscape Canopy Design MyTree

% i-Treeis a ‘ %L
Cooperative P Mﬂ/
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Public-Private Partnership

® USDA Forest Service

® Davey Tree Expert Co.

® National Arbor Day Foundation N\ The National
@ Arbor Day Foundation'

# Society of Municipal Arborists

® International Society of Arboriculture

® Casey Trees

®
nternationa Ll

CaseyTrees’
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What is i-Tree?

“Putting US Forest Service science into the hands of users.”

Benefits-based approach

* Based on peer-reviewed research

A 15-year collaborative effort

e Technical Support

i-Tree Users
Warldwide: 320,000+

* www.itreetools.org e

College of Environmental Science and Forestry

@ arbo ES
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i-Tree Conceptual Model Schematic
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Avoided Runoff
Energy Impacts




Why i-Tree?

Opportunities for communities to...

* Plan and manage urban forest resources more
strategically to serve and protect citizens;

* Integrate urban forests in policies: sustainability,
climate, resiliency, air quality, public health,
stormwater, etc.;

e Support advocacy efforts with data;

* Improve preservation of trees and forests;

e Connect urban and rural forest importance.




Why i-Tree?

Opportunities for communities to... s

Learning
Tree'

TEACHING WITH

[
Economic opportunities: I_Trge
attract & retain new businesses and residents; I

R

WEY% Estimates of Your Tree Benefits

Promote green tourism and investment;

Create green industry jobs;

Sustainable development;

Proven Solutionss for i Grow g, Work! Maore than an investment in beouty and shade, your trees work hard for youl!

Youth education & engagement; | I —

Prepared exclusively for: John Deere HQ

Estimated Tree Cover for your property: 43.7%

Develop new relationships & partnerships...  scouscmmsooe

each year by yourtrees:
13,004,647 gallons @ $115,741

Carbon Dioxide absorbed
each year by yourtrees:

2,876tons @ $101,412

Carbon Dioxide already
stored in your trees:
78.163tons @ $2.755.674



i-Tree’s Vision e

| Save on Your
| Energy Bills by
Planting Trees
To improve forest and human | i gl

health, and forest and city resiliency

through easy-to-use technology | |
that engages people globally in Help Us Breathe Easier
. Think about it...

enhancing forest management.




Estimating Tree Benefits

Air pollution removal

e Carbon storage and annual carbon
sequestration

* Avoided stormwater run-off (hydrology

effects)

Energy effects (home cooling & heating)

Structural assessment

S Value for ecosystem services

Public health impacts related to air
quality

S Urban Tree Canopy (UTC)
Wl Assessment for Massachusetts
10 Largest Communities

Urban Tf‘ée Canopy Cover Assessment
for the City of Chicopee

from a Climate Change Perspective




Tree species, size and |leaf area area are key to
calculating ecosystem services (benefits).

LEAF AREA =l

LURBAN FOREST BENEFITS =3

TREE SI1ZE/AGE i



Quantify Tree Benefits with  Research Science

Carbon dioxide storage and sequestration
Air pollution removal
Storm water reduction

$2.94 in benefits ngt fettire , '

for every $1.00 spent

Benefit Summary for
Pittsburgh’s Street Trees e

{ 10

Benefits Total ($)

Energy 1,205,133

€02 35,424 i S

anagement
Air Quality "252,035 . '.Ag i 5
Stormwater 334,601

Aesthetic/Other  ~5372.882

-3 Total Benefits *2.400.975

The only infrastructure
that increases in value
over time.




Research Science and Data Development

Commercial Practitioners

Citizen Scientists



What are your urban forestry challenges
and opportunities?

Executive Summary

Ioneer Vafley Plonnng Commvssion

PioneerValley
Climate Action and

Clean Energy Plan

oyt
D R e e ]
s et le KaBe e By men Fareng el Py e

March /2014




i-Tree Tool Selection Framework

. Database
My objectives?

Eco: Tree/Population

Ecosystem Services
Calculator

UTILITIES

* Tool advantages,
limitations, and
options?

Design:

Local-scale
management

* Available resources?

* Technical capacity or
skillset?

CORE PROGRAMS

e Timeline?

Landscape:
Regional-scale
management

 Audience?

e What does success

] ?
look like for me: i-Tree Tools & Model Relationships

SCIENCE



The Foundation: Local Data

*Local Sample or Inventory

*Local information:

e Weather

* Pollution

* Environmental
Variables

*Hourly simulations




Tree Benefit: Improve Air Quality

* Absorb pollutants through e, TR
leaf surfaces B e e o \

" O; (ozone)

" NO, (nitrogen dioxide)

" SO, (sulfur dioxide)

Gaseous Pollutants
Absorbed Through Leal
Stomates and Lenticels

\ | Advare o Surfaces
* Intercept dust and/or ~{
particulate matter (PM10 e
and PM2.5)

Trees Save Energy for Cooling and Heating,
Thereby Reducing Pollutant Emissions
from Power Plants

* A reduction in energy -
production needs reduces j
creation of many air |
pollutants g

(] Re | e a S e Oxyge n Image courtesy of the Center for Urban Forest Research



Improving Air Quality

Oxygen and Volatile Organic Compounds
e 15” Oak at 20 years (| bS) . Released Through the Leaves

* NO,=0.98
SO, =2.72
PM;,=0.52
Ozone =0.84
VOCs =0.21

Gaseous Pollutants
Absorbed Through Leaf
Stomates and Lenticels

Small Particles
\ Adhere to Surfaces
N/\_/

USDA Forest Service, Springfield, MA i-Tree, 2019 Image courtesy of the Center for Urban Forest Research



Tree Benefit: Reduce Carbon Dioxide CO,

* Trees are largely made of carbon |
so they take carbon out of the air - A .
and turn it into tissue (bark, RLE o
leaves, wood, etc.)

* Tree can help reduce home energy
needs, which also reduces
additional carbon emissions
released from power plants in the

CO: is Released Activities

first place (Secondary benefit) g “
and Mulch \M,

Image courtesy of the Center for Urban Forest Research



Reducing Atmospheric Carbon Dioxide

10” diameter deciduous shade trees

Trees Save Energy for Cooling,
Thereby Reducing CO, Emissions
from Power Pian

¢ 100 trees remove five tons
of CO,/year

¢ 100 trees remove about
1000 lbs of pollutants per
year, including:
400 lbs of ozone

300 Ibs of particulates

USDA Forest Service, Brattleboro, VT, i-Tree, 2020

Image courtesy of the Center for Urban Forest Research



Tree Benefit: Hydrology Effects

Intercepts and holds rain on S—

leaves, branches, and other anopy itercption Tl
and Evaporation o ‘

surfaces N

Transpiration

Reduces stormwater runoff

Increases water storage in N
SO|| Surface

Pervious
Surface

Increase infiltration and -,
helps reCharge aqUife rs - ‘ Evapotranspiration
(underground water) | S

N\

Roots Take Up Soil
Moisture, Increasing

b X Runoff Storage
Infiltration Potential

Reduces erosion

Image courtesy of the Center for Urban Forest Research



Trees & Energy — Summer Effects

Plant on the west & northwest to
provide mid-to-late afternoon shade in
most locations

o

Shade east & west windows,
but prune lower branches to
prevent blocking the view.

Plant shade trees over
| patios, driveways, and
, air conditioning units

Image courtesy of Arbor Day Foundation
https://www.arborday.org/trees



https://www.arborday.org/trees/

Trees & Energy — Winter Effects

Tree windbreak can reduce a 35-mph open wind velocity
to about 10-mph near here

...and about
15mph here

\.

Image courtesy of Arbor Day Foundation
https://www.arborday.org/trees,



https://www.arborday.org/trees/

Tree Benefit: Energy Effects Summary

* Trees shade buildings and
built surfaces (summer)

e Act as a wind break
reducing heat loss when
cold (winter)

® Trees cool the air — (climate effect)

® Reduce energy demand at power generation source
(Secondary benefit)

Image courtesy of the Center for Urban Forest Research



Conserving Energy

Wind Speed Reduction
Reduces Air Infiltration

Northeast U.S. Average

«Save up to 30% of
annual air conditioning
costs

«Save 10-25% of winter
heating costs

USDA Forest Service, i-Tree, 2021

Image courtesy of the Center for Urban Forest Research



www.itreetool.org Resoures

e

e

i-Tree delivers current, peer-reviewed tree benefits estimation science from

the USDA Forest Service toall types of users with free tools and support.

The trees around you:
remove hazardous pollutants from
the air you breathe,
absorb carbon dioxide from the air
to store as wood,

and control storm water by

Trees provide more than
just beauty and shade.

They work hard for all of
us, every day!

Click here to learn more.

intercepting and absorbing rainfall.

Tools for assessing individual trees

MyTree
Are you new to i-Tree? Start with our EASIEST tool! MyTree helps
you quickly assess individual trees with a minimum of fuss.

via your web browser or Android | Apple devices

i-Tree Design
A full-featured web tool with expanded building interactions and
forecasting for estimating the benefits of individual trees.

via your web browser

i-Tree Eco
Eco is our flagship tool that accommodates tree inventory IMPORT
or field data evaluation to derive individual tree benefit estimates.

requires installation on a Windows PC

Tree canopy area assessment tools

More tools...

OurTrees
Beta release: Quick tree canopy and related information for your

community within the continental US!

via your web browser or Android | Apple devices

i-Tree Landscape
US tree canopy and Census maps/data at your fingertips! Identify
priority planting & protection areas for climate & social issues.

via your web browser

i-Tree Canopy

From your chair, easily estimate land cover and tree canopy plus
benefits using random point sampling on aerial imagery.

via your web browser




MyTree

i-Iree.



i-Tree on the go...

@® treetools.org

s ... ' for individual or multiple trees!

i-Troe

MyTree Benefits ﬂ

Serving size: 1 ElIm, Chinese (Ulmus
parvifolia)

Carbon Dioxide(CO3) $108.34

CO; absorbed each year 2778.08lbs

Storm Water $28.63

Rainfall intercepted each year 4618 gal.

Air Pollution removed each year $1.82

MyTree Benefits

Serving size: 1 Eim, Chinese (Uimus.
parvifolia)

Ozone 12.00 oz

Carbon Dioxide(CO2)

Nitrogen dioxide 0.48 oz
Sulfur dioxide 0.16 07

Large particulate matter”™ 15.20 oz

Energy Usage each year $10.10

Electricity savings(A/C) 96.54 kWh

Fuel savings{NG,0i1) -13.99 therms

Avoided Emissions

Carbon dioxide 1223.201bs

Nitrogen dioxide 0.00 oz




MyTree

i-Iree.



i-Tree quick summary data for any community

OurTrees Home Project Menu~

A tree canopy assessment tool.

i-Iree.

OurTrees Where is your community?

[ ®

For the CONTINENTAL U S enter a city and state above and/or use the map below.
Q df l Reve !

i-Iree,

M#Assachusetts Bay

Hingham “

Get Results! =

VIS C O Satellite

Some locations may fail to calculate if no matching location is found in our
database — if your calculation fails please edit your location by spelling out

any abbreviations or try using a nearby city.




i-Tree quick summary data Boston, MA

OurTrees Benefits OurTrees
. i-ITree. iTree.
1.. ree Trees in Boston, MA Community
n Serving Size: Location! Location! Location! Context is important
16.96% tree canopy on 5,240 acres when it comes to the trees all around us. Here are
Ou rTreeS 60.45% impervious surfaces over 18,677 acres some fast facts from the U.S. census:
Total benefits for this year: $7,532,749
Boston, MA
Annual values: .
— Population
Carbon Dioxide Uptake $896,712
Total Population 617,594
Carbon Sequestered 5,256 tn
Under 5 32,420
: 1
CO; Equivalent 19,273 tn Under 18 103,710
Storm Water Mitigation $923,081 Over 64 62,237
Runoff Avoided 103 MG/yr Median Age 31 years
. Minority Percent 46.1%
Rainfall Intercepted 307 MGlyr
Air Pollution Removal $5,712,957 — Income Overview
Carbon Monoxide 4,632 |hlyr Median Income $50,684
Per Capita | 31,856
Ozone 178,000 Jp/yr er Capita Income 3
Percent Impoverished 15.9%
Nitrogen Dioxide 61,033 Jhlyr
Sulfur Dioxide 17,627 Iblyr. — Homes
PM, 5 12,898 Ihlyr Total Housing Units 272,481
Median Year Built 0
Median Value $395,200
Carbon Dioxide Uptake $34,197,062
Carbon Storage 200,453 tn + Household Types
€O, Equivalent' 734,994 tn + Home Tenure
1
Benefits are based on USDA Forest Service Benefits are based on USDA Forest Service
research and are meant for guidance only. Visit research and are meant for guidance only. Visit
www.itreetools.org to learn more. www.itreetools.org to learn more.
=+ Read the fine print *Read the fine print.
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I-Tree Canopy

Quick, statistical
estimate of Canopy
cover and associated
benefits.

* Create custom cover
classes

 Random point locations

* Does not automatically
assign cover class at point

Enhanced Ul coming soon!

]

B 2855 Wosdcret Dive Faslimn OH % @ - Tree Canogy: Defise Prepect st « |

coy itreatool g dali re gy

I-Tree Canopy.

Define Project Area

$)oa -

Ll

BSave SLoad T hop

Cover Classes
Cover Class Abbreviabon
ree T Tree, non-sheub
2 NonTree NT All other surfaces
L | = Page 1 of 1

Select Froject Locations Selected Locations
T Ckescrobia ® Lne:id States of Amancs
7 Crangs ®onca

T Cuosoy ® Cranze

Benefit Options
Yihich regemsen) Toos Canupry?
BT Tres
INT Nen Trze

T Palin Seach O Al ORuwsl ©Uman

Passe
Pl
Palk =
P.tnam
Z Santa Resa
o Sarascta
© Samiak
T 5t Jorns
T S. Lucie =

id Cover Class
1 Tree
Noo-Tree [2]

Tree

Tree Tree, non-shrub 17 1
A other surtaces NT 49

co Carbon Monoxide removed annually $174.40 +47.52  656.72 Ib
NO2 Nitrogen Dioxide removed annually $156.26 +42.58 1511.651b

03 Ozone removed annually $9,24984 +2520.35 948T
PM2.5 Particulate Matter less than 2.5 microns removed annually $17,94275 +4,888.94 848.77Ib
S02 Sulfur Dioxide removed annually $6.22 +1.69 133.891b

PM10* Particulate Matter greater than 2.5 microns and less than 10 microns
removed annually

CO2seq Carbon Dioxide sequestered annually in trees

$6.763.14 1184278 2487

$81,60357 +2223490 231464T

Carbon Dioxide stored in trees (Note: this benefit is not an annual

CO2stor rate) $1,321,118.93 £359,971.39 3747284 T 1




preview

I-Tree Canopy

(_

C @ localhost

ﬂ iree Canopy .. e F tYy M - Tree

-Tree

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey
areasr

-J
ght on the map, or load in one or more shapefiles
-
<%

"

Select a Shapefile

The easiest option is to select a pre-existing boundary, but you can draw your own

2
Q

_
=
=
=
=_
=

B Load ESRI Shapefile

Draw or Add Areas

Use one of these tools to s

=

Map data £2019 Imagery 2019 NASA TerraMetrics | Terms of Use




preview

I-Tree Canopy

¢ C O localhost

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey

areas right on the map. or load in one or more shapefiles

o

n is to select a pre-

xisting boundary, but you can draw your own

Map dats 820

9 imagery ©2019 NASA TerraMatrice | Terms of Use




preview

I-Tree Canopy

ﬂ i-Tree Canopy X B
¢ C @ localhost:3001/map# * DEE OO0

ﬂ i-Tree Canopy . ne Project Menu~ Tree Feedback

+Iree

Configuration step 1 of 3: Use the map and tools provided to define the area you want to survey. The easiest option is to select a pre-existing boundary, but you can draw your own
areas right on the map, or load in one or more shapefiles.

Launch Our Example Project

Ready to survey your own 0? Use these

netiane b defi
functions to define mo,

Administative

R O US Census Block G P <
R O US Census Places /
P 4

R O County Subdivisions

~
R O US Counties
R O US 115" Congressional Districts

@ (O US States 7

Load ESRI Shapefile

Draw or Add Areas

P

Map data ©2019 Imagery 22019 NASA TerraMetrics | Terma of Use




preview

I-Tree Canopy

= (] X

@ i-Tree Canopy x +
&« C @ localhost:8001/survey * @ @ 00
- ss Home Projecty Menu~ i-Tree Feedback ~
% i-Tree Canopy ... .

Conduct your survey: With each point you add, the map will shift to a new, random location where you assess the land cover at the yellow crosshairs in the center of the map. The more
points you survey, the lower your standard error, and the more precise your sampling will be. More points provide a better estimation of Land Cover across your study area.

ID Cover Class Latitude Longitude
Impervious Other 41.74094 -72.65320
Impervious Road 41.74315 -72.66277
Tree/Shrub 41.76941 -72.68937
Grass/Herbaceous 41.78738 -72.69409
Tree/Shrub 41.73479 -72.67216
Impervious Other 41.78946 -72.66989
Tree/Shrub 41.79791 -72.71115
Tree/Shrub 41.74369 -72.66156
Grass/Herbaceous 41.80402 -72.71483

10 Grass/Herbaceous 41.79908 -72.65136

+ 2 M M Page1ofS0 W




Q& Ve Canapy x + R
€ 3 C O hcalhostdnrepon " @RB2 00
! i'Tree Canopv Ay Homo Propcty RBegoty Meru v -Teee Feedbace
I-Tree Canopy v6.1
Cover Assessment and Tree Benefits Report i
Extimated wxing ravdom ampling watistics om 117479 g I-TI'CC
Land Cover H Grass/Hertaosous "3 2264147 406034 ¢
T Trea/S2ud »m /2197 411035
bt :
.S - t B Inpenvows Euldngs 4 1484159 2664029
W Tree'shrub R Irtgennows Roed 4 02125 1552023
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; ()
o £ W Wt 2 4202090 0762016
| Wt B me
m B $5lBace Groued g S SoilBaeGroud 1 280407 oaren3 .
[ ] — : o o Abbr, Descrigtion Value (USD) +SE Ameunt (T) =5E
> - ©  CarbonMonaids remoned snnualy 204242 415330 s
m3 A NO2 Nivogen Dvonde reroved arnualy $1.95581 1880 &15 061
m Tree Benefit Estimates: Carbon (Engli
ot} Onone remoed ssnudlly §77.039.58 578238 STST 32
& 0= Deseription Carbon (T) )
PM2s Particulate Matter less than 2.5 microns semoved ancusly $15619615 NTIT6S 236 021
Q Cover Class AT e | so2 Subir Dicids remaned ancualy $12028 2903 158 0
Stored in vees (Note not an nnual rate} 10671151 £7.784) = 5 ) %
o O At S e R i i PMI0 Particulate NMatter greaner than 2.3 microns and less $han 10 micrors removed annually §26.900.52 201908 A1 +0.£0
Total 5264,17487 193283 8141 %1
GrasMerbeoscus H . . .
Tree Benefit Estimates: Air Pollution (E A Dot Extnetes oot Sesed on st aives i Bubcsee @ S0 0 2 1 § SR22T ORS00 @ SO0 0F 30960 @ 5142A2| 025 140 § 54200 19 ) SO0 1000 @ KD | IM1” S0 § 52272 Curvemey 3 i L0 Dot wvoes of
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Fall River

Prepared using i-Tree
Canopy, a state —of-
the-art analysis tool,

developed by the US

Forest Service and
its key research
partners.




Massachusetts Ten Largest Communities by Popu




Tree Canopy Cover 34%
Tree Cover (sq. mi.) 2.08
Tree Canopy Cover Value
5 3984187.41

Tree Canopy Cover 31%
Tree Cover (sq. mi.) 4.59
Tree Canopy Cover Value
$ 8808326.99
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Tree Canopy Cover 36.7%
Tree Cover (sq. mi.) 11.8
Tree Canopy Cover Value

$22642220.86

a

Tree Canopy Cover 39.3%
Tree Cover (sq. mi.) 14.1

Tree Canopy Cover Value
$27026730.16

Tree Canopy Cover 59.3%
Tree Cover (sq. mi.) 18.7
Tree Canopy Cover Value
$35983596.36

Tree Canopy Cover 40.5%
Tree Cover (sq. mi.) 4.58

Tree Canopy Cover Value
$ 8790730.11

Tree Canopy Cover 27.9%
Tree Cover (sq. mi.) 13.9
Tree Canopy Cover Value
$ 26.587.698.27

Tree Canopy Cover 43.1%
Tree Cover (sq. mi.) 7.21

Tree Canopy Cover Value
$ 13837228.31

Tree Canopy Cover 45.9%

Tree Canopy Cover 32.8%
Tree Cover (sq. mi.) 6.58
Tree Canopy Cover Value
$12,623,87.04

Tree Cover (sq. mi.) 9.88
Tree Canopy Cover Value
$ 18965875.33
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Boston Urban Forest Canopy Assessment
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Tree Benefit Estimates

Abbr. Benefit Description | Value *SE Amount *SE
CO Carbon Monoxide removed annually $340.09 +19.34 401T +0.23
NO2 Nitrogen Dioxide removed annually $585.50 +33.30 21.87T £1.24
03 Ozone removed annually $30,491.74 +1,734.09 21784 T +12.39
PM2.5 Particulate Matter less than 2.5 microns removed annually $63,032.01 +3,584.69 1059 T +0.60
SO2 Sulfur Dioxide removed annually $102.33 +5.82 13.78 T +0.78

Particulate Matter greater than 2.5 microns and less than 10
microns removed annually

CO2seq Carbon Dioxide sequestered annually in trees $844,821.44 +48,045.80 43,62995T +2,481.28

Carbon Dioxide stored in trees (Note: this benefit is not an
annual rate)

PM10* $22,136.22 +1,258.91 7297 T +4.15

CO2stor $25,626,188.94 +1,457,385.70 1,323,438.65 T +75,265.21

i-Tree Canopy Annual Tree Benefit Estimates based on these values in Ibs/acre/yr and $/T/yr: CO 0.902 @ $85.08 | NO2 4.917 @ $26.86 | O3 48.968 @
$140.47 | PM2.5 2.379 @ $5,975.67 | SO2 3.098 @ $7.45 | PM10* 16.403 @ $304.43 | CO2seq 9,807.385 @ $19.43 | CO2stor is a total biomass amount of
297,489.961 @ $19.43

Note: Standard errors of removal amounts and benefits were calculated based on standard errors of sampled and classified points.

About i-Tree Canopy

The concept and prototype of this program were developed by David J. Nowak, Jeffery T. Walton and Eric J. Greenfield (USDA Forest Service). The current
version of this program was developed and adapted to i-Tree by David Ellingsworth, Mike Binkley, and Scott Maco (The Davey Tree Expert Company).
Limitations of i-Tree Canopy

The accuracy of the analysis depends upon the ability of the user to correctly classify each point into its correct class. As the number of points increase, the
precision of the estimate will increase as the standard error of the estimate will decrease. If too few points are classified, the standard error will be too high to
have any real certainty of the estimate.

A Cooperative Initiative Between:
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EEpAVEYHE @ scvor vavroundasion G2 [SHL A ey

www.itreetools.org

mpervious Surfaces IS 373 46,6 +1.76
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Project Configuration Data

[Project: Adrian] [Serie;drian_ZOIZ] [Year: 2012] -Eee?co v6.0.3

(= | E et

Project Land Ground Dieback
Definition = Use Cover

Define Data Fields

N

View Reports Forecast Support
Load from File 2= @ ‘—J/
B3 via Gooagle Maps
(&3 o Project & c Editing
2 User Defined Strata Area Mode: Off
Define Plot Export

Help

Project Configuration > Project
Definition > Project Settings

The Project Settings tab seen in the
action panel to the right is where you
identify many of your most important
project settings.

Steps:

1. Enter a name for your project in
the box provided. Your project
name gives your i-Tree Eco
project a unique identity. This is
also the name that will be used
when referring to your study
area in your model results
(available on the Reports tab of
the ribbon).

2. Enter a series name for your
project in the box provided.
Again, your series name helps to
give your project a unique
identity. It can be used to
identify the exact nature of the
project - for example,
“ParkTrees” or “City" - to
distinguish it from other Eco
projects done at the same time in
the same place, if necessary.
This series name can be used in
the future to reference the data
for this project.

3. Enter a series year in the box
provided. It is recommended that
you enter the year of your data
collection for this variable.

-~

m

Project Configuration > Project Definition

Enter project overview information and click OK to save it or Cancel to quit this
process.
Project Settings ‘ Location | Data Collection Options

What name would you like to give your new project?
Project Name: |Adrian

What name would you like to give your series?
Series Name: Adrian_2012

Please specify the series year for your project:
Series Year: 2012

Please specify the following inventory information:

Inventory Type: Plot Sample

iI-Tree Eco v6

Flagship tool with best
estimates for Composition and
Benefits.

» User interface & Help text
* Reporting

* Tree inventory import

* Mobile data collector

Help text

Plot Sampling & Complete
Inventories



i-Tree Eco v6

[Project: Adrian] [Series: Adrian_2012] [Year: 2012] - i-Tree Eco v6.0.3 E@]ﬂ
Project Configura Data View Reports Forecast Support
—= 0p0 17 = . .
(28 & [{@sMaA DS [ | Flagship tool with best
Paper ' Submit  Retrieve Plots Trees Shrubs Check | CSV KML | Benefit Annual Editing g p
Form ' to Mobile from Mobile Data Prices Costs | Mode: Off . f e, o
Data Collection ‘ Inventory Data ‘ Export ‘ Inventory Value’ | e St I l I I ate S O r CO I I l pOS It I O n
Help q d B f M
~ | Data > Inventory Data > Trees a n ene ItS.
Data > Inventory Data > Trees Tl
The Trees table seen in the action Plot ID Survey Date Status Distance (ft) Direction Species 3
panel to the right displays the tree
data that you collected in the field 1 1 4/24/2012 Planted 0.00 140 | Red maple (Acer rubrum)
(s.e e Notes below). This is where you = 2 1 4/18/2012 Ingrowth 21.20 208 | Boxelder (Acer negundo)
will enter your tree data manually or .
edit your previously added or 2 2 4/18/2012 Ingrowth 31.00 206 | Boxelder (Acer negundo) ° U ser | nte rfa ce & H e I p Text
imparied date. Wiile working in this 3 1 4/25/2012 Planted 30.70 178 | Freeman maple (Acer x freemanii)
table, you may use the tools in the
Actions group to help manually enter 4 1 4/23/2012 Ingrowth 21.30 32 | Tree of heaven (Ailanthus altissima, .
new data or edit data that has ] e 2 4/23/2012 Plarted 240 224 | Norway maple (Acer platancides) ° Re p ortin g
already been added.
| D 4 3 4/23/2012 Planted 37.20 298 Northem white cedar (Thuja occide
itepé ItokMan:a“g Add}{ Edit Data: y 7 1 4/19/2012 Ingrowth 35.00 14 | Siberian elm (Uimus pumila) . .

. ick in the box where you wou T t m t
like to enter data and begin 7 2 4/19/2012 Planted 30.00 80 | Honeylocust (Gleditsia triacanthos) ¢ re e I nve n O ry I p O r
typing. 7 3 4/19/2012 Ingrowth 26.80 130 | Black walnut (Juglans nigra)

2. Usethe Tab key on your - .
keyboard or the left and right 7 4 4/159/2012 Ingrowth 22.30 258 | Blue spruce (Picea pungens) ° M O b I I e d ata COI Ie Cto r
arrows to move from side to side 8 1 4/24/2012 Ingrowth 28.20 20 | Siberian elm (Uimus pumila)
within a record. -
3. Usethe up and down arrows on 8 2 4/24/2012 Ingrowth 25.80 30 | Black walnut (Juglans nigra)
the keyboard to move from top to 8 3 4/24/2012 Ingrowth 28.10 43 | Norway maple (Acer platanoides) PY H e I t ext
bottom between records. ) - p
4. For boxes that contain drop- 1" 1 4/27/2012 Ingrowth 11.80 338 | Shellbark hickory (Carya laciniosa)
down lists, you can choose your 1 2 4/27/2012 Ingrowth 15.20 338 | Black chemy (Prunus serotina)
thaia from the I.'St or beg|rj typing 1 3 4/27/2012 Ingrowth 3460 352 | American elm (Ulmus americana)
and the matching label will be
automatically filled in. 1" 4 4/27/2012 Ingrowth 10.00 0 | American elm (Ulmus americana)
5. Thetable can be sorted by 1 5 4/27/2012 Ingrowth 17.70 10| Black cheny (Prunus serotina)
column in ascending or .
descending order. To sort, click 1 6 4/27/2012 Ingrowth 3520 20 | Siver maple (Acer saccharinum) P I ot S am p I N g & CO m p I ete
on the desired column header. 1 7 4/27/2012 Ingrowth 15.10 20 | Buttemut (Juglans cinerea)
6. For boxes where dates are .
entered, a calendar pop-up will " 8 4/27/2012 Ingrowth 28.70 30 | American elm (Ulmus americana) I n Ve n to r I e S .
appear if you click on the < >
i i icht-hand



Adrian)] [Series: Adrian_2012] [Vear: 2012] - i-Tree Eco v6.0.3 B T) i-Tree Eco VG
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Mobile data collector
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* Basic mapping

Shagbark hickory
_ Eastern redbud

- Northern hackberry
T Alaskacedar

- Flowering dogwood

Plot Sampling & Complete
Inventories.




i-Tree Eco - Data Import Wizard " @

Select an inventory column below and then define how to import it into Eco. Repeat for EACH

at that time. Pl
your data, the
may not reflect
made. To ensur
data to the se
again.

column BEFORE clicking Next

DEH Trunks

Cond | Canity

‘ WeakFork

ij |

i-Tree £co - Data Import Wizard

Total records procesesd. 520
Total records skipped: 7
Total records to mpert: 483

Processed Dala to Import

Review the results of your processed data.

Species

Acer ubrum

Please review your data after chcking Finish. Addtional modfications may be required to meet your project specrfic requIrements.

Cick Finigh Lo complets the import process or cick Back Lo revies your sstings end reprocess your dats.

[ <Beck || Ensh | [ Conce |

I Prunus seroting

Prunus sarotina

i-Tree Eco v6

Flagship tool with best

estimates for Composition
and Benefits.

e User interface & Help text
* Reporting

* Tree inventory import

* Mobile data collector

* Basic mapping

Plot Sampling & Complete
Inventories.
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- o - o tive_Use] erar: 2010] - i-Tree Eco v6.0.3 I = ‘ O X I -Tre e E co VG

Plot1-GPS Loc...

Help

Land Use Plot Info

Type in coordinates, use device GPS, or tap a location

Data > Data (

Status 1-Ingre

Mobile Land Uses Dead Tree? on the map below.
i-Tree Eco of || I P'rection () Ground Covers Crown Condition 85% - 90% )
recording the Lt : Latitude 41.908656011
the field. Onq Distance (ft) Reference Objects Height (ft)
record your L [
R ongitude -84.0385827151
datta)'[w::lletcm Street Tree Trees Crown Top Height (ff) [
mobilie data
:nmaaﬂ;c:'g:;b Comment | rom wmp = se builgng <o Shrubs Crown Base Height (ft) cessing Device GPS (allow location access on device):
our collecte] ] — Slﬂl m— ——
me e vt Mark Plot as Completed Crown NS Width (ft) dress
tab of ribbo!
functionali Crown EW Width (ft) Timestamp
have to dow . access |,
web-based i Crown Percent Missing | 93 V) Tree Accuracy (ft)
form. n.
Crown Light Exposure 4 (v :
The purpose proi Tap map for coordinates (requires data connection):
function seer Percent Impervious 0 (v
the right is tc ——
configuration | Percent Shrub 63 (V) ne

will be able tf
mobile device
mobile data
below).

*IMPORTANT
Before you ca
mobile data co!
device, you must SEGS
configuration here (see ™
If you do not submit your project
configuration, you will not be able to
access the mobile data collector from
your mobile device.

[C]|3260 11/1/2010




Reports > Map > Composition and Structure of Individual Plots

Note. this tool only aisplays valic LoTtude and Longtuge cooraingres.
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© OpenStreetMap contributors.

i-Tree Eco v6

Flagship tool with best
estimates for Composition
and Benefits.

e User interface & Help text
* Reporting
* Tree inventory import

e Mobile data collector

* Basic mapping

Plot Sampling & Complete
Inventories



I-Tree Landscape




Boundaries

i'Tre e Lan d sCape : i Main CanoPy  Fores! Administaive

(@) us Census Block Groups
Climate 2020 (RCP 4.5)

Gateway to tree benefits — available to anyone and it | O usCensusPlaces
everyone in the US. Camale 2030 (RCP 45) (X US County Subdivisions

Climate 2040 (RCP 4.5) ( uscounties

() us 115" Congressional Districts
Climate 2050 (RCP 4.5)

* Uses existing boundaries. [ @ us states

Climate 2060 (RCP 4.5)

* Canopy, Land, and Impervious Cover across i 2070 PP 41 Forest (US Forest Service)
the US. » (@ National Forests
e UTC-sendus you rs! ) G e ( Ranger Districts
* High Resolution Urban Tree Canopy Assessments Climate 2090 (ACP 4.5)
e 250+ map |ayers o Climate 2100 (RCP 4.5)
b 7 base map.s - Olmsted*alls Climate 2020 (RGP 8.5)
* 10 boundaries, plus 26 federal types ,
o 7 canopy and land Climate 2030 (RCP 8.5) Nl US Federal Lands
* 6 forest risk, plus 47 pests Climate 2040 (RCP 85) Native American Reservation
e 17 health ris|.< Climate 2050 (RCP 8.5) Bureau of Land Management
* 144 future climate Find Locations e 2060 (1CP 85)
* Upto 18 new ones coming with v5.0 Bureau of Reciamation
Climate 2070 (RGP 8.5)
* 1,000's of data attributes and tree benefits i 2080 e 85 pepaimentofbetense
organized for easy exploration. ST
Climate 2090 (R ) -
. . [ . The following descriplions ol ™ (FR84)
o P I a ntl ng p rl O rlt I Zat I On tOOI more details and a thorough Forest Service
Climate 2100 (RCP 8.5) -

'
Let S Get Star Note: Predicted temperature and precipitation based Fish and Wildlife Service
on CCSM4.0 from Nafional Center for Atmospheric
Each i-Tree Landscape ploq Research.

National Park Service

shown below the map. (To

Map defails are localed in the references.




@ Explore LocationData -~ X | + x |
&« > C @ OO8 ntps:landscape itreetools.org/maps/locations/ ezl N €@ »

i-Tree La n d Sca pe ﬂi i-Tree Landscape ... Home Projects Menu~  iTree Feedback +

————— e P — ——

Start on Main, then explore the map layer tabs.

=11

Gateway to tree benefits — available to Euchd _ ool el
anyone and everyone in the US. e Main | oland Risk Rk  Cimate
o ) Base Maps -
Geve “dl {  Boundaras +
LTeveland A
A good place to get people started R ;
I n I_Tre e . &y Vilsge Lakow(%}i . Choose a boundary area to analyze:
_r@—- ROy BIE Shaker H . Peppy
Eﬂ»‘f«]l‘de & ah i Bl | s US Census Block Group :l @
. B3 & rafienra | - o %ﬂ \_ = Use these tools to work with the map:
A q u IC k to u r Ofu e i = = 422 + Navigata i wentty
orth Olmsted ﬁ 2 Mpple Heghts @ |
o Parma adfagg ! % o
e |ocation Data o Brook Park >d_{,lj\:;}’ sefofs g Fof] | @ seea O Box Select

. . ? — = Geo-Swap
* Making a selection
d lassificati o——
[ J
La n Cove r C aSSI |Cat|0 ns Find Locations Explore Location Data See Tree Benefits Prioritize Tg
Map details are located in the references.
* and tree canopy :
Land Cover @ Unit Display
o ThematIC ma pplng m HiRes = 2011 | 2001 Metric | English Table Chart m
Canopy Legend
Data Tools Area Land Cover HiRes Land Cover 2011 Census [ Minimum: 0.8 “uture Climate

Maximum: 271.8

Canopy & Impervious Forest Details mn| [ | O -

Lighter colors reprasant lower values, whia
darker colors represant higher values

Area warrwpy nipor vivus Plantable Space
f i
@ % PE % W% W%

Remove Dalaset ¢ Type ¢ Name ¢ ID ¢ Swap Highlight acre $ % ¢ acre ¢ % ¢ acre ¢ % ¢ acre ¢ % ¢

v Selection Total: O 52,829.7 100.00 95476 19.18 25629.6 51.49 14,5239 29.18




i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...

 Tree Benefits

e Carbon (CO?), air pollution,
hydrology

* Planting Prioritization
* Weighted prioritizations
* Custom scenarios

* Maintenance vs new planting
* (vs highest priority; i.e. both)

&) Prioritize Tree Planting X } +

& - C ® | ®© & httpsi//landscape.itreetools.orgimaps/prioritize/

Find Locations Explore Lecation Data See |
Land Cover @
I
€ Back HiRes | 2011 = 2001

How To Prioritize Tree Planting

To map optimal areas to plant trees, create a "Prority Planting Index"

scenario from user-specified, weighted criteria (under Custom Scenarios)
or use one of the Commen Scenarics (abeve). Scenarios are based upon

the Land Cover dataset selected (above) - HiRes, 2011, 2001.

The three Common Scenarios are:

« Population: (default) an index weighted towards areas of relatively

high population density, low tree cover per capita, and high
available planting spaca.

« Minorities: an index weighted towards areas of relatively high
minonty population density, low tree cover per capita, and high
available planting space.

« Poverty: an index weighted towards areas of relatively high
proportion of population below the poverty ine, low tree cover per
capita, and high available planting spaca

To create a Custom Scenario:
1. Select from one or more criteria (the blue boxes under Custom

Scenarios) by using the + Add Criteria button and their drop-down.

» For each criteria, set an Importance (from 0 to 100). The
sum cf the all weights must equal 100.
» Optional: to distribute weights equally among the selected
criteria, click the Equalize button.
2. Click Update Map Display to see the results on map (above) and
legend (below).
3. Each Custom Scenario can be stored by clicking Store Scenario.
These saved scenarios can be included in your report when you
Generate Results

Current Prioritization Scenario Legend

The index is from 0 to 100, where 0 is a low priority and 100 is a high

B % IN € @ »

TTTTTTNUMT-WOOURO U TOW OENTSITy UBNRIOpRU 210U

*

Wooded to high density developed 2100
Wooded to low density developed 2100

Priority Planting Index Extras

Tree Stocking Level

Tree Cover per Capita

Population Below Poverty Line
Minority Population Density

Tree Canopy Benefits

Carbon Storage

Carbon Sequestration

CO: Equivalent Storage

CO: Equivalent Sequestration
CO Removal

NO:z Removal

Q3 Removal

PM;.5 Removal

High = Low

{ )
o

Trow Coverpor Capita 1 I

Imporiance (welght)

= Equalize

© Update Map Display

+ Add Crileria Slore Scenario

Stored Planting Prioritization Scenarios

Remember to update the map's display after restoring a custom

priority. prioritization scenario.
How? Remove Title Criteria Restore
__Each criteria is standardzed on a scale of 0 to 1, with 1 reoresenting the P v c r——

Population Density (3




i-Tree Landscape

Gateway to tree benefits — available to
anyone and everyone in the US.

A good place to get people started
in i-Tree.

A quick tour of...
* Reporting

* Title and description
 Example tables
 Example thematic map

Example prioritization map

landscape.itreetools.org

¥ Report - i-Tree Landsca; X 4+
- >

C @@ ®O& nhtps//landscape itreetools.org/reports

Tree Benefits
barbon and CO2 (Hig

Selection Total: 1887085

EPrioritization

h Resolution UTC)

Carbon COz Equivalent CO; Equivaient

Carbon Storage Sequestration Storage Sequestration
Short Ton

¢ $yr & tUyr ¢ $ ¢ ShortTong $yr o vyr s

11,0646 60,259 3533 1,887.066 40,570.0 60,259 1.29552

iPopuIatIon (High Resolution UTC

der Prer 0

Edgewater
ark
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I-Tree Planting




ﬂ i-Tree Planting ..,  Home Project~  Menu~  i-Tree

i-Tree.

Welcome to the i-Tree Planting Calculator! ..,

The i-Tree Planting Calculator is designed to help you estimate the long-term environmental benefits from a tree

planting project. The focus is on greenhouse gases, but many co-benefits are included.

This is a newly updated version of i-Tree Planting. Please clear your web browser's cache for this site before using.

Users enter the following information:

The following information is calculated (in units and associated dollar values) for the project life time:

Tree species

Size of trees at planting

Information on the distance and direction to the nearest building (optional)
Information about the tree’s growing conditions

Estimated mortality (optional)

The number of trees with each configuration

Project lifetime (number of years)

Specific greenhouse gas values (optional)

Greenhouse Gas (GHG) sequestered and avoided (owing to reductions in energy use)
Energy conserved

Air pollutants captured and avoided

Stormwater filtered

Tree total biomass

QN A DEPAK
A m

#o e Uy

";ﬂ'“ L Tec,

california |
Eiurbanforests .

Urban Ecos

Feedback v

i-Iree

Planting

O Get Started

Use of this tool indicates
acceptance of the EULA.



A collaborative initiative with

‘}':JE 6TRY &FIRE PRO
0}

= ORNIA DEPART

NT,
ritngf'

% |—Tree PIant'ng o Home Project » Menu ~ i-Tree Feedback v

i-Iree
Location Parameters Trees Report
Location

Select a location at, or near, the project site.

State/Province

<>

Massachusetts

County/Division

<>

Hampden

City
Springfield

<>

WARNING: If you already have tree groups entered, they will be retained, but changing the location will change the Report results.

Each of the three location selections needs to be completed in order:

e State
e County
. City

At this time, the i-Tree Planting Calculator is only for users located within the United States. Please contact support@itreetools.org for more information
about funding needed for your area.
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Project Parameters

Configure the local parameters for the project.

Electricity Emissions Factor
505.21

This field is required.
Units
pounds GQ» equivalent/MWh ® kilograms GO» equivalent/MWh

vvvvvvvv At ottt S

Fuel Emissions Factor
68.71

This field is required.
Units

Years for the Project (1 thru 99)

40

Tree Mortality over Project Lifetime, as an estimated percentage (Optional, 0 thru 100)

10
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Tree Planting Configurations
Enter the tree groups for the project.
Units

@® English (feet & inches)  © Metric (meters & cm)

Nomenclature

® Common Name © Scientific Name

Tree Group Information Building Information Tree Details

Distance
to
DBH in  Nearest Tree is of Climate Exposure to Nu|
Species inches in feet Building Vintage Controls Condition Sunlight

v Apple i(0-19 7)i( North (0°) %)i( Built after 1980 %)
Apple, Paradise i H H i
Ash
Ash, American mountain
Ash, Black
Ash, Carolina
Ash, European mountain
Ash, Green
Ash, Summit
Ash, White
Aspen, Bigtooth
Aspen, Quaking
Baldcypress
Basswood
Basswood, American
Bayberry, Southern
Beech

(Heat& A/C ) i ( Excellent ¥ i (FulSun %)

Use of this tool indicates acceptance of the EULA.
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Planting Report 8 Print

NOTE: Printing is recommended as the "landscape" orientation or at a reduced scale.

Project Report - i-Tree Planting Calculator.,,;

Location: Springfield, Massachusetts 01109 n
Electricity Emissions Factor: 505.21 kilograms CO2 equivalent/MWh I-TI‘ ccC.
Fuel Emissions Factor: 68.71 kilograms CO2 equivalent/MMBtu Planting
Lifetime: 40 years

Tree Mortality: 10%

All amounts in the tables are for the full lifetime of the project.

Units
@® English (pounds & tons; kWh & MMBtu; gallons)  © Metric (kilograms & metric tons; KWh & MMBtu; cubic meters)

Copy Export CO,  Energy Eco Air Pollution Search:
Location CO, Benefits
It co, co, co, o,
Group Avoided Avoided Sequestered Sequestered
Identifier Tree Group Characteristics (pounds) $) (pounds) $)
1 e (1.0) Apple (Malus species) at 1.0 inch DBH. 2,649.2 $61.61 2,192.2 $50.98
o Planted 0-19 feet and north (0°) of buildings that were built post-1980 with heat
and A/C.

o Trees are in excellent condition and planted in full sun.
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Caring for the land and serving people
United States Department of Agriculture
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David Bloniarz

USDA Forest Service
David.Bloniarz@usda.gov
txt 413-537-3748



